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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Windows and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the 

United States and/or other countries. 

PC/AT is a trademark of International Business Machines Corporation. 

Pentium is a trademark of Intel Corporation. 

 

The information in this document is current as of December, 2004. The information is subject to 
change without notice.  For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not 
all products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)

•

•

•

•

•

•

M8E  02. 11-1

(1)

(2)

"NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries.
"NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above).

Computers, office equipment, communications equipment, test and measurement equipment, audio
and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.
Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).
Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

"Standard":

"Special":

"Specific":
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GENERAL  PRECAUTIONS  FOR  HANDLING  THIS  PRODUCT 
 

1. Circumstances not covered by product guarantee 

• If the product was disassembled, altered, or repaired by the customer 

• If it was dropped, broken, or given another strong shock 

• Use at over voltage, use outside guaranteed temperature range, storing outside guaranteed 

temperature range 

• If power was turned on while the USB cable or target system connection was in an unsatisfactory 

state 

• If the USB cable, target cable, or the like was bent or pulled excessively 

• If the product got wet 

• If the product and target system were connected while a potential difference existed between the 

GND of the product and the GND of the target system 

• If a connector or cable was removed while the power was being supplied to the product 

• If an excessive load was placed on a connector or socket 

 

2. Safety precautions 

• If used for a long time, the product may become hot (50°C to 60°C).  Be careful of low temperature 

burns and other dangers due to the product becoming hot. 

• Be careful of electrical shock.  There is a danger of electrical shock if the product is used as 

described above in 1 Circumstances not covered by product guarantee. 
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Regional Information

•  Device availability

•  Ordering information

•  Product release schedule

•  Availability of related technical literature

•  Development environment specifications (for example, specifications for third-party tools and
   components, host computers, power plugs, AC supply voltages, and so forth)

•  Network requirements

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary
from country to country.

[GLOBAL SUPPORT]
         http://www.necel.com/en/support/support.html

NEC Electronics America, Inc. (U.S.)
Santa Clara, California
Tel: 408-588-6000
       800-366-9782

NEC Electronics Hong Kong Ltd.
Hong Kong
Tel: 2886-9318

NEC Electronics Hong Kong Ltd.
Seoul Branch
Seoul, Korea
Tel: 02-558-3737

NEC Electronics Shanghai Ltd.
Shanghai, P.R. China
Tel: 021-5888-5400

NEC Electronics Taiwan Ltd.
Taipei, Taiwan
Tel: 02-2719-2377

NEC Electronics Singapore Pte. Ltd.
Novena Square, Singapore
Tel: 6253-8311

J04.1

NEC Electronics (Europe) GmbH
Duesseldorf, Germany
Tel:  0211-65030

• Sucursal en España
Madrid, Spain
Tel:  091-504 27 87

Vélizy-Villacoublay, France
Tel:   01-30-67 58 00

• Succursale Française

• Filiale Italiana
Milano, Italy
Tel:  02-66 75 41

• Branch The Netherlands
Eindhoven, The Netherlands
Tel:   040-244 58 45

• Tyskland Filial
Taeby, Sweden
Tel:  08-63 80 820

• United Kingdom Branch
Milton Keynes, UK
Tel:  01908-691-133

Some information contained in this document may vary from country to country.  Before using any NEC 
Electronics product in your application, pIease contact the NEC Electronics office in your country to 
obtain a list of authorized representatives and distributors.  They will verify: 
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PREFACE 
 

 

Target Readers This manual is intended for users who use the PG-FPL2 when designing and 

developing a system using an NEC Electronics on-chip flash memory 

microcontroller.  

 

Purpose This manual is intended to give users an understanding of the basic specifications 

and correct use of the PG-FPL2. 

 By using the PG-FPL2, programs can be easily erased from or written to the flash 

memory of an NEC Electronics 78K0S/Kx1+ Series on-chip flash memory 

microcontroller, or can be verified on WindowsTM screens, while the microcontroller is 

mounted on the user board.  

 

Organization This manual includes the following sections. 

 

• Overview 

• Hardware installation 

• Software installation 

• Operation using GUI software  

• Usage examples 

• Connectors and cables 

• Notes on target system 

• Circuit diagrams 

• Troubleshooting 

 

How to Read This Manual To understand the overall functions and usage of the PG-FPL2, read this manual in 

the order of the CONTENTS.  

 Be sure to read CHAPTER 4  OPERATION USING GUI SOFTWARE because this 

chapter presents important information for using the PG-FPL2.  

 It is assumed that the readers of this manual have general knowledge of electricity, 

logic circuits, and microcontrollers.  

 In the explanations of the operation of the applications, it is also assumed that the 

readers have sufficient knowledge of Windows.  

 For the usage and terminology of Windows 98, Windows Me, Windows 2000, and 

Windows XP, refer to each Windows manual. 

 

The mark  shows major revised points. 
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Conventions Note:   Footnote for item marked with Note in the text. 

Caution:   Information requiring particular attention 

Remark:   Supplementary information  

Numeral representation: Binary … ×××× or ××××B 

  Decimal … ×××× 

  Hexadecimal … 0××××H or ××××H 

“ ”:   Any character or item on screen 

 OK :   Name of button 

[ ]:   Menu 

< >:   Dialog box name 

 

Terminology The meanings of the terms used in this manual are as follows. 

Term Meaning 

FPL2 Abbreviation of flash memory programmer PG-FPL2 

GUI software Windows application to operate PG-FPL2 using GUI software 

Target device NEC Electronics on-chip flash memory microcontroller 

Target system User-designed board on which NEC Electronics on-chip flash 

memory microcontroller is mounted 

FP4 connector Abbreviation of PG-FP4 target connector (type A) 

FA adapter Adapter board to write programs to NEC Electronics on-chip flash 

memory microcontrollerNote 

78K0S/Kx1+ Generic name of 78K0S/KU1+, 78K0S/KY1+, 78K0S/KA1+, and 

78K0S/KB1+ 

 

Note The FA adapter board is a product of Naito Densei Machida Mfg. Co., Ltd. 

 If you have any questions about the FA adapter board, contact: 

    Naito Densei Machida Mfg. Co., Ltd. Tel: +81-45-475-4191 
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CHAPTER  1   OVERVIEW 
 

 

The PG-FPL2 is a tool that erases and writes programs on an NEC Electronics 78K0S/Kx1+ Series on-chip flash 

memory single-chip microcontroller on the target board or FA adapter board.   

 

1.1 Features 
 

• The PG-FPL2 is a compact flash memory programmer for an on-chip flash memory microcontroller, and is 

designed for development. 

• The USB interface is available for connection with the host. 

• The PG-FPL2 allows on-board programming without removing the target device from the target system. 

• Only single-wire UART interface is supported for data transfer to the target device. 

• Device-specific parameters required for programming can be read from the parameter file (PRM file). 
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CHAPTER  2   HARDWARE  INSTALLATION 
 

 

2.1 System Requirements 
 

Host PC A PC supporting Windows 98, Windows Me, Windows 2000, or Windows XP is required to run 

the FPL2 in the graphical user interface (GUI) mode. 

 About 2 MB of free hard disk space is required to install the GUI software. 

Host machine IBM PC/ATTM or compatible 

 CPU: PentiumTM 100 MHz or more 

 RAM: 32 MB or more 

Host interface USB interface that enables communication based on USB (Ver. 1.1 or later). 

File formats Program files can be used in Motorola HEX file format or Intel HEX file format. 

 

2.2 Package Contents 
 

Please verify that you have received all the parts listed in the package contents list included with the FPL2 

package.  If any part is missing or seems to be damaged, please contact an NEC Electronics sales representative or 

distributor. 
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2.3 System Configuration and Components 
 

The FPL2 system configuration is as given in the diagram below. 

 

Figure 2-1.  FPL2 System Configuration 
 

 

USB cable 
(Mini-B type)Note 1 

 

Target system 

compatible with FP4 

connector 

Host machine 

Target cable
 FPL2-FA 

 PG-FPL2 

 FA adapterNote 2 

 ID78K0S-QB Disk 

Target system not 

compatible with FP4 

connector 

 

Notes  1.  Use the USB cable (Mini-B type) included with the QB-78K0SKX1MINI. 

 2.  The FA adapter board is a product of Naito Densei Machida Mfg. Co., Ltd. 

 

The FPL2 is connected to the host machine via the USB cable (Mini-B type).  The FPL2 is connected to the user 

system via the target cable.  For the detailed specifications of the target cable and connector, refer to CHAPTER 6 

CONNECTORS AND CABLES. 

 

2.3.1 FPL2 display specifications, connector, and MODE switch settings 

 

Figure 2-2.  Layout Drawing of Connectors and LEDs 

 

 

 
 

 

 

MODE switch

Target cable connector 

USB connector

Power LED Status LED 
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Target cable connector: Used to connect the connector of the target cable. 

USB connector:  Used to connect the USB cable to be connected to the host machine. 

Power LED:  Turned on in green when the FPL2 is connected to the host machine. 

Status LED:  Blinks in red when the FPL2 is communicating with the target device. 

MODE switch:  Switches power to be supplied to the target system. 

Target: Used to supply VDD from the target system. 

3 V: Used to supply power to the target system with 3.0 V VDD from 

the FPL2. 

 

Caution When the Status LED is blinking, communication with the target device is in progress.  Do not 

disconnect the target cable and USB cable. 

 

2.3.2 FPL2-FA connector 

 

Figure 2-3.  Layout Drawing of FPL2 Connectors 

 

 

 

   
 

 

 

Target connector:  Used to connect the tip of the target cable. 

FP4 connector:  Used to connect the FA adapter board or target system. 

 

2.3.3 Target system 

The target system must be equipped with a device interface that complies with the target cable specifications.   

Refer to CHAPTER 6  CONNECTORS AND CABLES for details. 

 

2.3.4 USB connector 

The shape of the USB connector is a Mini-B type. 

Refer to CHAPTER 6  CONNECTORS AND CABLES for details. 

 

2.3.5 Target cable 

The tip of the target cable can be connected to the header pin that is 0.635 mm by 0.635 mm. 

Refer to CHAPTER 6  CONNECTORS AND CABLES for details. 

 

Target connector 

FP4 connector 

Component side (front) Soldering side (rear) 
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2.3.6 Connection procedure 

The procedure for connecting the FPL2 is described below. 

 

Caution Be sure to install the software (GUI software driver) before making connections. 

 

(1) Set the MODE switch according to the power supply of the target system. 

 

Caution Be sure to set the MODE switch before making connections with the host machine and target 

system.  If connections are made based on an incorrect setting, the FPL2 and target system 

may be damaged. 

 

Figure 2-4.  MODE Switch Setting 

 

  
 

(2) Connect the host machine with the FPL2 via the USB cable.  (Check that the Power LED is turned on in green.) 

 

Cautions 1. Be sure to perform this step before making a connection with the target system.  If 

connections are made in an incorrect order, the FPL2 and target system may be damaged. 

 2. When the MODE switch is set to 3 V (power is supplied from the FPL2), the voltage output 

to the VDD pin when the FPL2 is connected with the host machine. 

 

(3) Connect the target system with the FPL2. 

 

(a) When FPL2 is connected with a target system that has a 16-pin connector usable with the FP4 connector 

 

<1> Connect the tip of the target cable with the target connector of the FPL2-FA. 

 Connect the tip of the target cable with the target connector of the FPL2-FA so that the number 

marked on the tip of the target cable matches to the number marked on the FPL2-FA board. 

 

Remark The FPL2-FA is connected with the target cable at shipment. 

 

 

 

Set the MODE switch. 
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Figure 2-5.  Connecting Target Cable with FPL2-FA 

 

  
 

 

 

 

 

 

<2> Make sure that the power to the target system is not turned on. 

 

Caution Make sure that the power to the target system is not turned on before connecting 

the target cable.  If the target cable is connected after the power to the target system 

is turned on, the FPL2 may be damaged. 

 

<3> Connect the FP4 connector with the connector installed in the target system. 

 

Caution When the MODE switch is set to 3 V (power is supplied from the FPL2), VDD is always 

output from the FP4 connector. Be sure to remove the FP4 connector before 

inserting or removing a device in the target system. 

 

<4> Be sure to turn on the power to the target system. 

 (When the MODE switch is set to 3 V, power is supplied from the FPL2, so this step is not required.) 

 

(b) When the FPL2 is connected with the target system without using the FPL2-FA 

 

<1> Disconnect the FPL2-FA from the target cable. 

<2> Make sure that the power to the target system is not turned on. 

 

Caution Make sure that the power to the target system is not turned on before connecting 

the target cable.  If the target cable is connected after the power to the target system 

is turned on, the FPL2 may be damaged. 

 

<3> Connect the tip of the target cable marked "0.GND" to GND of the target system. 

 

Caution Be sure to connect "0.GND" at the beginning.  If connections are made in an 

incorrect order, the FPL2 and target system may be damaged. 

 

<4> Make sure that the power to the target system is not turned on. 

0. G
N

D
 

Match the number. 

Tip of target cable 
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<5> Connect the tip of the target cable marked "2.VDD" to VDD of the target system. 

 

Caution Be sure to make connections in the order from "0.GND" to "2.VDD" to "other signals".  

If connections are made in an incorrect order, the FPL2 and target system may be 

damaged. 

 

<6> Connect the tips of other target cables to the target system. 

<7> Turn on the power to the target system. 

 (When the MODE switch is set to 3 V, power is supplied from the FPL2, so this step is not required.) 

 

2.3.7 Disconnection procedure 

 

(1) When communication with the target system ends, terminate the GUI software. 

 

(2) Disconnect the FPL2-FA from the target system. 

 

(a) When the FPL2 is connected with the target system by using the FPL2-FA 

 

<1> Turn off the power to the target system. 

 (When the MODE switch is set to 3 V, power is supplied from the FPL2, so this step is not required.) 

<2> Disconnect the FPL2-FA from the target system. 

 

Caution When the MODE switch is set to 3 V, the FPL2 outputs power at all times.  Be sure to 

disconnect the FP4 connector from the target system before disconnecting the 

target device. 

 

(b) When the FPL2 is connected with the target system without using the FPL2-FA 

 

<1> Turned off the power to the target system. 

 (When the MODE switch is set to 3 V, power is supplied from the FPL2, so this step is not required.) 

<2> Disconnect the tips of the target cables marked "1./RESET", "3.DGCLK", and "4.DGDATA" from the 

target system. 

 

Caution Be sure to disconnect the target cables in this order.  If the target cables are 

disconnected in an incorrect order, the target system or the FPL2 may be damaged. 

 

<3> Disconnect the tip of the target cable marked "2.VDD" from the target system. 

<4> Disconnect the tip of the target cable marked "0.GND" from the target system. 

 

(3) Disconnect the USB cable from the host machine.  (Make sure that the Power LED is turned off.) 

(4) Disconnect the USB cable from the FPL2. 
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CHAPTER  3   SOFTWARE  INSTALLATION 
 

 

3.1 GUI Software Installation 
 

The GUI software allows easy and comfortable access to all features of the FPL2 flash programmer.  

The installation program is contained in the CD-ROM (ID78K0S-QB Disk) included with the QB-78K0SKX1MINI 

package. 

Execute the following steps to install the GUI software. 

 

(1) When using Windows XP, log on as the computer administrator.  When using Windows 2000, log on as the 

Administrator. 

 

(2) Insert the CD-ROM (ID78K0S-QB Disk) included with the QB-78K0SKX1MINI package into the CD-ROM drive. 

 

(3) Double-click "My Computer", "CD-ROM", "PG-FPL2", and "SETUP" in that order.  Double-click "setup.exe" in 

the SETUP folder. 

 

Figure 3-1.  SETUP Folder 

 

 
 

 

 Double-click 
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(4) Select a language to be used for installation ("English" in this example), then click   OK  . 

 

Figure 3-2.  Setup Language Selection 

 

 
 

(5) After selecting the language, the window shown below is displayed. 

 Click  Next >  to continue installation. 

 

Figure 3-3.  Installation Start 

 

 
 

 

Select language 
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(6) The software License Agreement window appears.  Read the displayed license agreement carefully, then click  

   Yes  if you accept the agreement.  You need to accept the agreement before using the PG-FPL2.  If you do not 

accept the agreement, click  No  to terminate the installation of the software. 

 

Figure 3-4.  License Agreement Window 

 

 
 

(7) Check that "Typical" is selected, then click  Next > . 

 

Figure 3-5.  Setup Type 

 

 
 

Check that "Typical" is selected.
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Remark By selecting Custom, only the GUI software or document can be installed.  The GUI software 

installation destination can be changed by clicking  Browse... .  This manual assumes the default 

installation folder. 

 

•  When  Browse...  is clicked 

 The directory selection window is displayed.  Specify the path for the installation folder and then click  OK . 

 

Figure 3-6.  Changing Installation Folder 

 

 
 

•  When Custom is clicked 

 Select the checkbox of the item to be installed and then click  Next > . 

 

Figure 3-7.  Custom Installation 

 

 

Specify an installation destination folder path. 

Check here when installing the GUI software.

Check here when installing documents.

Click after confirming the check boxes.
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(8) Specify or select the program folder and then click  Next > . 

 

Figure 3-8.  Program Folder Selection 

 

 
 

(9) Confirm the current setting and then click  Next > .  (Program installation starts.) 

 

Figure 3-9.  Start of File Copy Operation 
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(10) When installation of the GUI software is complete, the screen shown below appears.  Click  Finish  to 

terminate the installer. 

 

Figure 3-10.  Completion of Installation 

 

 
 

(11)  The following folders are created upon completion of installation. 

 

Figure 3-11.  Folder Configuration After Installation 

 
C:\

\Program File

\NECTool32

\bin

\PRM

\doc

\PG-FPL2
[ FPL2.exe ]
[ FPL2ctl.dll ]

\DRIVER
[ Pgfpl2.inf ]
[ Pgftpl2.sys ]

\PG-FPL2
[ PG-FPL2_UM_E.pdf ]
[ README_E.pdf ]

Folder specified as the installation destination

PRM file storage folder

GUI software

This manual

Notes on using
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3.2 USB Driver Installation  
 

The driver needs to be installed in the host machine before using the FPL2.  Install the driver according to the 

following procedure: 

 

Installation in Windows 98/Me:  See 3.2.1  Installation in Windows 98/Me 

Installation in Windows 2000: See 3.2.2  Installation in Windows 2000 

Installation in Windows XP:  See 3.2.3  Installation in Windows XP 

 

3.2.1 Installation in Windows 98/Me 

 

(1) When the FPL2 is connected with the host machine, the FPL2 is recognized by Plug and Play, and the wizard 

for adding new hardware is started.  Click  Next > . 

 

Figure 3-12.  Add New Hardware Wizard (Windows 98) 
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(2) The window below is displayed.  Check that "Search for the best driver ..." is selected, then click  Next > . 

 

Figure 3-13.  Search Method (Windows 98) 

 

 
 

(3) Check the "Specify a location" check box only and enter "C:\Program Files\NECTools32\bin\PG-

FPL2\DRIVER" in the address bar, then click  Next > . 

 

Figure 3-14.  Search Location Specification (Windows 98) 

 

 
 

 

 

Remark If the installation destination folder is changed for GUI software installation, enter "new-

folder\bin\PG-FPL2\DRIVER". 

 

Check that "Search for the best 

driver ..." is selected. 

Check "Specify a location" only. 

Enter "C:\Program Files\NECTools32\bin\PG-FPL2\DRIVER". 
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(4) The window below is displayed.  Confirm the contents and click  Next > . 

 

Figure 3-15.  Checking Driver to Be Installed (Windows 98) 

 

 
 

(5) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation. 

 

Figure 3-16.  Completion of Installation (Windows 98) 
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3.2.2 Installation in Windows 2000 

 

(1) When the FPL2 is connected with the host machine, the FPL2 is recognized by Plug and Play, and the wizard 

for finding new hardware is started.  Click  Next > . 

 

Figure 3-17.  Found New Hardware Wizard (Windows 2000) 

 

 
 

(2) The window below is displayed.  Check that "Search for a suitable driver ..." is selected, then click  Next > . 

 

Figure 3-18.  Search Method (Windows 2000) 

 

 
 

Check that "Search for a 
suitable driver ..." is selected. 
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(3) Check the "Specify a location" check box only, then click  Next > . 

 

Figure 3-19.  Driver File Location (Windows 2000) 

 

   
 

(4) Enter "C:\Program Files\NECTools32\bin\PG-FPL2\DRIVER" in the address bar, then click  Next > . 

 

Figure 3-20.  Address Specification (Windows 2000) 

 

 
 

 

 

 

Remark If the installation destination folder is changed for GUI software installation, enter "new-

folder\bin\PG-FPL2\DRIVER". 

 

Check that "Specify a 
location" only is checked. 

Enter "C:\Program Files\NECTools32\bin\PG-FPL2\DRIVER". 
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(5) The driver file is searched and the window below is displayed.  Click  Next > . 

 

Figure 3-21.  Driver File Search (Windows 2000) 

 

 
 

(6) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation. 

 

Figure 3-22.  USB Driver Installation Completion (Windows 2000) 
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3.2.3 Installation in Windows XP 

 

(1) When the FPL2 is connected with the host machine, the FPL2 is recognized by Plug and Play, and the wizard 

for finding new hardware is started.  Check that "Install from a list or specific ..." is selected, then click  Next > . 

 

Figure 3-23.  Found New Hardware Wizard (Windows XP) 

 

 
 

(2) Check that "Search for the best driver in these locations." is selected.  Check the "Include this location in the 

search:" check box and enter "C:\Program Files\NECTools32\bin\PG-FPL2\DRIVER" in the address bar, then 

click  Next > . 

 

Check that "Install from a list or
specific ..." is selected. 
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Figure 3-24.  Search Method (Windows XP) 

 

   
 

 

 

 

(3) When installation of the USB driver is complete, the screen shown below appears.  Click  Finish  to complete 

installation. 

 

Figure 3-25.  USB Driver Installation Completion (Windows XP) 

 

 

<1> Check that "Search for the 
best driver in these locations." is 
selected. 

<2> Check "Include this 
location in the search:" only. 

<3>  Enter "C:\Program Files\NECTools32\bin\PG-FPL2\DRIVER". 
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3.3 Confirmation of USB Driver Installation 
 

After installing the two types of drivers, check that the drivers have been installed normally, according to the 

procedure below.   When using the FPL2, the information to be checked here is needed. 

 

Click the "Device Manager" tab and check that the drivers are installed normally. 

 

Figure 3-26.  Device Manager  
 

 
 

Cautions 1. When using the FPL2 in Windows 98/Me, do not select  Refresh  or  Remove  when 

communicating with the target device. 

 2. When using the FPL2 in Windows 2000/XP, do not perform “Scan for hardware changes” when 

communicating with the target device. 
 

Remark If the drivers above are not displayed, or the mark "×" or "!" is prefixed, refer to CHAPTER 9 

TROUBLESHOOTING. 
 

Check that "NEC Electronics IE-PC Interface 

[PG-FPL2]" is present. 
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3.4 Uninstallation 
 

3.4.1 Driver uninstallation 

Uninstall the driver by manually deleting "NEC Electronics IE-PC Interface [PG-FPL2]" on the "Device Manager" 

tab while the FPL2 is connected. 

After deletion, Find New Hardware wizard may start.  At this time, click Cancel. 

 

3.4.2 GUI software uninstallation 

The driver uninstallation program is contained in the CD-ROM (ID78K0S-QB Disk) included with the QB-

78K0SKX1MINI package (this program is used commonly as the installer). 

Use the procedure below for driver uninstallation. 

 

(1) When using Windows XP, log on as the computer administrator.  When using Windows 2000, log on as the 

Administrator.  

 

(2) Insert the CD-ROM (ID78K0S-QB Disk) included with the QB-78K0SKX1MINI package into the CD-ROM drive. 

 

(3) Double-click "My Computer", "CD-ROM", "PG-FPL2", and "SETUP" in that order.  Double-click "setup.exe" in 

the SETUP folder. 

 

Figure 3-27.  SETUP Folder 

 

 
 

 

 

Double-click
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(4) Select a language to be used for installation ("English" in this example), then click   OK  . 

 

Figure 3-28.  Setup Language Selection 

 

 
 

(5) Select "Remove", then click   Next >  . 

 

Figure 3-29.  Program Modification 

 

 
 

(6) Click  OK  to start uninstallation. 

 

Figure 3-30.  Confirmation of File Deletion 

 

 

Select language 

Select “Remove”. 
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(7) When uninstallation of the GUI software is complete, the screen shown below appears.  Click  Finish  to 

complete uninstallation. 

 

Figure 3-31.  Completion of Maintenance 
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CHAPTER  4   OPERATION  USING  GUI  SOFTWARE 
 

 

4.1 Introduction 
 

Before you start using the FPL2, download the parameter file for the target device (.PRM) to the PRM folder. 

 

<Downloading the parameter file> 

The PRM file is not part of the FPL2 software package.  

It has to be downloaded from the following NEC Electronics website. 

 

http://www.necel.com/micro/ods/eng/index.html (website in English) 

http://www.necel.com/micro/ods/jpn/index.html (website in Japanese) 

 

The PRM file downloaded from the NEC Electronics website must be copied into the sub-directory <FPL2.EXE-

installation-path>\PRM which was created during GUI software setup (see CHAPTER 3 SOFTWARE 

INSTALLATION).  

 

4.2 Starting up GUI Software 
 

• GUI software startup 

Select FPL2.EXE in the Start menu to start the FPL2 GUI software. 

When the GUI software is started normally, the following screen appears. 

 

Figure 4-1.  GUI Software Main Window  

 

 
 

Toolbar 

Menu bar 

Action log window 

Status bar 

Programmer parameter window 
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This window consists of the following items. 
   

Name Description of Display 

Menu bar (displayed at the top) Displays menu items executable by the FPL2. 

Toolbar (displayed under the menu bar) Displays frequently used commands as icons. 

Action log window (displayed under the toolbar) Displays an FPL2 action log. 

 

Programmer parameter window 

(displayed to the right of the action log window) 

Displays programming parameter settings. 

 

Status bar Displays status. 

 
4.3 Toolbar 
 

The toolbar contains buttons to start the most important procedures of the FPL2. 

 

Table 4-1.  Toolbar Buttons 

 

[Device] – [Setup…] button 

  

 

[File] – [Load…] button 

  

 

[Device] – [Blank check] button 

  

 

[Device] – [Erase] button 

  

 

[Device] – [Program] button 

  

 

Device Erase – [Autoprocedure (EPV)] button 

 

4.4 Menus 
 

Depending on the actual device status or device type, some menu items may be enabled or disabled.  

 

4.4.1 [File] menu 

After clicking the [File] menu, the following pull-down menu is displayed. 

Commands related to file operation appear here. 
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Figure 4-2.  [File] Menu 

 

 
 

(1) [Load] command  

The [Load] command allows you to select a program file.  The selected program file will be 

programmed into the device’s flash memory by executing the [Program] command or [Autoprocedure 

(EPV)] command. 

 

Figure 4-3.  HEX File Selection Window 

 

 
 

The most recently used directory from which a file has been loaded will be offered in this window as the default 

selection.  After loading the user program, the checksum is calculated and the result is displayed in the 

programmer parameter window. 

 

[ Open  button] 

Selects a user program as a program to be written to the target device. 

 

[ Cancel  button] 

Closes the window without selecting a program. 

 

(2)  [Quit] command 

The [Quit] command terminates the FPL2 GUI software.  Clicking the  X  button on the right side of the task 

bar also terminates the FPL2 GUI software. 

User settings are saved in the FPL2.ININote file so that the GUI software will start up next time with the same 

settings. 

 

Note FPL2.INI is created in the Windows folder when Windows 98, Windows Me, or Windows XP is used. 

 When Windows 2000 is used, FPL2.INI is created in the Winnt folder. 
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4.4.2 [Device] menu 

Clicking the [Device] menu displays the following pull-down menu.  

This pull-down menu mainly consists of commands for programming the target device, such as erase, program, 

and verify. 

 

Figure 4-4.  [Device] Menu 

 

 
 

(1) [Blank Check] command 

The [Blank Check] command initiates a blank check of the target device connected to the FPL2.  If 

the flash memory of the target device is erased, the blank check terminates successfully.  If the flash 

memory is not completely erased, “not blank” is displayed.  Erase the flash memory of the target device before 

starting programming. 

 

(2) [Erase] command 

The [Erase] command initiates the erase procedure for the target device connected to the FPL2. 

While erasing the contents in the flash memory is in progress, the progress is displayed in the action 

log window, indicating the operation of the programmer. 

The [Blank Check] command that is executed before the [Erase] command is executed in accordance with the 

setting of ‘Command options’ on the Advance tab of the [Device] > [Setup…] menu. 

After completing the [Erase] command, the GUI software displays the target device command execution result. 

 

Caution During an erase operation, the Status LED is not turned on.  Do not disconnect the target 

cable and USB cable until the GUI software displays "Erase finished".  Otherwise, the target 

device may be damaged. 

 

(3) [Program] command 

The [Program] command transmits the specified user program and writes them to the flash memory.  

After execution of the [Program] command, to display and verify the checksum values of the target 

device and the user program to detect a communication error of the user program while it is being transmitted, 

set ‘Command options’ on the Advance tab of the [Device] > [Setup…] menu. 
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While programming is in progress, the progress is displayed in the action log window, indicating the operation 

of the programmer.  This progress indicates the progress of programming the target device as a percentage. 

After completing the [Program] command, the GUI software displays the target device command execution 

result. 

 

(4) [Verify] command 

This command is not supported. 

 

(5) [Security] command 

The [Security] command initiates the programming of the security flag of the target device connected to the 

FPL2.  Set ‘Security flag settings’ on the Advance tab of the [Device] > [Setup…] menu. 

 

(6) [CheckSum] command 

The [CheckSum] command initiates the displaying and verifying of the checksum values of the target device 

connected to the FPL2 and the user program.  "OK” is displayed if the values match, and “ERROR: checksum 

does not match” if the values do not match. 

 

(7) [Autoprocedure (EPV)] menu 

The [Autoprocedure (EPV)] command sequentially executes the [Erase] and [Program] commands 

explained above. 

After execution of the [Autoprocedure (EPV)] command, to verify the checksum values of the data written to the 

flash memory of the target device and the program file to detect a communication error of the user program 

while it is being transmitted, specify automatic execution of the [CheckSum] command after execution of the 

[Program] command, using the Command options on the Advance tab of the [Device] > [Setup…] menu.  

During EPV, the progress status of the programmer operation is displayed in the action log window.  Refer to 

CHAPTER 5  USAGE EXAMPLE for the selected command, and its execution operation and message. 

After completing the [Autoprocedure (EPV)] command, the GUI software displays the target device command 

execution result. 
 

(8) [Signature read] command 

 This command is not supported. 
 

(9)  [Setup…] command 

The [Setup…] command is used to perform flash memory writing settings in accordance with the 

user environment, and command option settings.  Each time the GUI software is started, the 

parameter file (.PRM) and customized setup file (.SET) that were used last are read, and their setting contents 

are displayed.  Settings can be changed in accordance with the user environment, except for the parameters 

that are dimmed.  In addition, new settings can be saved to the customized setup file (the data of the 

parameter file cannot be changed). 
 

(a) Standard setup 

This menu is used to set the rewriting environment of the target device’s flash memory.  

The mode of communication with the target device and the operating clock of the device differ depending 

on the device used.  Refer to the manual of the device used for details. 

The following window opens. 
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Figure 4-5.  Device Setup Window – Standard Tab 

 

 
 

This window shows all basic options that can be set in accordance with the user environment and target 

device.   

 

[ OK  button] 

Saves the settings in the Standard and Advance tabs and closes the window. 

 

[ Cancel  button] 

Closes the window without saving the settings in the Standard and Advance tabs. 
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<1> Parameter file 

This file holds parameters and timing data required to rewrite the flash memory of the target device.  

Do not modify the data in the parameter file because the data is related to the guarantee of rewrite 

data. 

The parameter file is protected by the checksum function.  If the checksum result indicates an error, 

the FPL2 does not accept the parameter file. 

 

Figure 4-6.  Device Setup Window – Parameter File Selection 

 

 
 

Figure 4-7.  Parameter File Selection Window 

 

 
 

 

[ PRM File Read  button] 

A window for specifying a parameter file is displayed.  Specify the target file and click  Open . 
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<2> Communication interface to device  

Select the channel for communication between the FPL2, target device, and host machine, in this 

area.   

 

Figure 4-8.  Device Setup Window – Communication Interface to Device 

 

 
 

[Port box] 

Displays the communication channel between the FPL2 and target device. 

• UART-ch0  

 

Remark Since the target device of the FPL2 is the 78K0S/Kx1+, the port is fixed to UART-ch0.  

 

[Speed box] 

Displays the communication rate of the communication channel. 

• 115,200 bps  
 

Remark Since the target device of the FPL2 is the 78K0S/Kx1+, the communication rate is fixed to 

115,200 bps.  
 

<3> Supply oscillator 

Select the clock that determines the programming, data transfer, and transfer rates, in this area. 

 

Figure 4-9.  Device Setup Window – Supply Oscillator 
 

 
 

[Frequency box] 

Sets the clock frequency of the target system.  

 

Remark Since the target device of the FPL2 is the 78K0S/Kx1+, the clock frequency is fixed to 8 

MHz.  

 

[Multiply rate] 

Specifies the division rate or multiplication rate of the target device. 

 

Remark Since the target device of the FPL2 is the 78K0S/Kx1+, this item is fixed to 1.00.  
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<4> Operation Mode  

The flash memory may be divided into blocks or areas depending on the target device.  

This menu is used to select the operation mode of the flash memory.  Some devices do not have 

either or both division modes Block and Area.  In this case, a mode that is not available cannot be 

selected. 

 

Figure 4-10.  Device Setup Window – Operation Mode Selection 

 

 
 

[When Chip is selected] 

The entire flash memory area of the target device is subject to rewrite processing. 

 

[When Block is selected] 

Specify the Block number range subject to rewrite processing by using Start/End.  

The Start/End list boxes display the Block number where the flash memory of the target device is 

configured.  

 

Remark The Start Block number is fixed to 000.   Specify the End Block number only. 

 

[When Area is selected] 

This item is not supported. 

 

[Show Address check box] 

Specifies whether numbers or addresses are displayed in the Start/End list boxes.  

If this check box is checked, addresses are displayed. 

If it is not checked, numbers are displayed. 
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(b) Advance setup 

This menu is used to specify command options and security flag setting. 

The Advance tab is displayed by clicking Advance. 

 

Figure 4-11.  Device Setup Window – Advance Tab 

 

 
 

 

<1> Command options 

Specify the options for the FPL2 flash processing commands in this area. 

 

Figure 4-12.  Device Setup Window – Command Options 

 

 
 

[Blank check before Erase check box] 

If this check box is checked, a blank check is performed before execution of the [Erase] and 

[Autoprocedure (EPV)] commands.  If the result of the blank check is OK, erase processing is not 

executed. 

 

[Read verify after Program check box] 

This item is not supported. 

 

[Security flag after Program check box] 

If this check box is checked, automatic programming of the selected security flag is executed after 

execution of the [Program] and [Autoprocedure (EPV)] commands.  
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[Checksum after Program check box] 

If this check box is checked, the checksum values of the target device connected to the FPL2 and 

the user program are displayed and verified after execution of the [Program] and [Autoprocedure 

(EPV)] commands.  

The value shown in this box differs from the value displayed in the parameter window in the main 

window. 

"OK” is displayed if the values match, and “ERROR: checksum does not match” if the values do not 

match. 

 

<2> Security flag settings 

The <Security flag settings> dialog box is used to specify which security function is valid.  

 

Figure 4-13.  Device Setup Window – Security Flag Settings 

 

 
 

[Disable Chip Erase check box] 

If this check box is checked, the [Erase] command becomes invalid in the entire flash memory area 

of the target device. 

At this time, the warning message shown below is displayed. 

 

Figure 4-14.  Device Setup Window – Disable Chip Erase Warning 

 

 
 

Caution Be aware that if the security flag is set in the target device, neither erasing nor 

writing to the device can be enabled afterward. 

 

[Disable Block Erase check box] 

If this check box is checked, the [Erase] command becomes invalid in all the blocks of the flash 

memory selected under Operation Mode in the Standard Setup menu. 

This setting is cleared by the [Erase] command when Chip was selected under Operation Mode. 

 

[Disable Program check box] 

If this check box is checked, the [Program] command becomes invalid, as does the [Erase] command 

in all the blocks of the flash memory selected under Operation Mode in the Standard Setup menu. 

The [Erase] command for the entire flash memory area is valid. 

This setting is cleared by the [Erase] command when Chip was selected under the Operation Mode. 
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Caution The following is the correspondence between the [Erase] and [Program] commands 

when the security functions of a 78K0S/Kx1+ Series microcontroller are valid. 

 

 CHIP Erase Command Block Erase Command Program Command 

Disable Chip Erase Invalid Invalid ValidNote 

Disable Block Erase Valid Invalid Valid 

Disable Program Valid Invalid Invalid 

 

Note Since the Erase command is invalid, the data that differs from the data already written in the 

flash memory cannot be written. 

 

4.4.3 [View] menu 

Clicking the [View] menu displays the following pull-down menu. 

This menu consists of commands for commands for setting whether to display the toolbar and status bar. 

 

Figure 4-15.  [View] Menu  

 

 
 

(1) [Toolbar] command 

Checking the [Toolbar] command displays the toolbar.  Unchecking the command hides the toolbar.  

 

(2) [Status Bar] command 

Checking the [Status Bar] command displays the status bar.  Unchecking the command hides the status bar.  
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4.4.4 [Help] menu 

Clicking the [Help] menu displays the following pull-down menu. 

 

Figure 4-16.  [Help] Menu  

 

 
 

(1) [About FPL2] command 

The [About FPL2] command opens the following program entry window and indicates the version.  

Clicking  OK  terminates the display. 

 

Figure 4-17.  About FPL2 Window 
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4.5 Programmer Parameter Window 
 

This window displays the settings of the programming parameters. 

 

Figure 4-17.  Programmer Parameter Window 

 

 
 

[Parameter file] 

Displays information about a parameter file updated and read after [Setup] command execution. 

 

[Load file] 

Selects information about a program file updated and selected after [Load] command execution. 

 

[Connection to device] 

Display information about the connection with the target device. 

 

Remark Since the target device of the FPL2 is the 78K0S/Kx1+, this item is fixed so it cannot be changed.  
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CHAPTER  5   USAGE  EXAMPLE 
 

 

This chapter explains a series of basic operations of the FPL2 with the GUI software, taking a case where the 

µPD78F9222 is used as the target device as an example.  This chapter covers how to start the system, execute the 

[Autoprocedure (EPV)] command, and program the target device. 

Refer to CHAPTER 4 OPERATION USING GUI SOFTWARE for the other commands and applications. 

 

O  Series of operations described in this chapter 

The conditions of the series of operations described in this chapter are as follows: 

 

• Target system 

Target device: µPD78F9222 
Voltage level: 3 V 

Communication: UART CH0 

 

• FPL2 

Parameter file: 78F9222.PRM 

Clock setting: 8 MHz  

Port: UART-ch0 (115,200 bps) 

MODE switch: 3 V 

Operation mode: Chip 

Write HEX: FPL2_TEST.HEX 

Option setting: Blank check before Erase 

 Checksum after Program 

 

(1) Installing the GUI software 

Install the FPL2 GUI software in the host machine you are using, by referring to CHAPTER 3 SOFTWARE 

INSTALLATION (if the software has not been installed yet). 

 

(2) Installing the driver 

Install the USB driver in the host machine you are using, by referring to CHAPTER 3 SOFTWARE 

INSTALLATION (if the driver has not been installed yet). 

 

(3) Installing the parameter file 

Copy the parameter file for the µPD78F9222 to the hard disk and install it in <FPL2-installation-path>\PRM. 
Download the parameter file from the following: 

 

 http://www.necel.com/micro/ods/eng/index.html (website in English) 

 http://www.necel.com/micro/ods/jpn/index.html (website in Japanese) 
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(4) Connecting and starting the system 

<1> Set the MODE switch to "3 V". 

<2> Connect the FPL2 with the host machine via the USB cable. 

<3> Check that the Power LED is turned on. 

<4> Check that the power to the target system is not turned on, then connect the FPL2 with the target system 

via the target cable. 

<5> Start the GUI software. 
 

Figure 5-1.  GUI Software Main Window 
 

 
 

(5) Setting the programming environment 

<1> Select [Device] → [Setup] from the menu bar. 
<2> The Device Setup window for device setup is activated. 

 

Figure 5-2.  Device Setup Window – Standard Tab 
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<3> Click  PRM File Read  to open the parameter file selection window. 

 In this case, select the parameter file for the µPD78F9222 then click  Open . 

 

Figure 5-3.  Parameter File Selection 

 

 
 

<4> Set the items in the Operation Mode field so that the FPL2 is adjusted to the user programming 

environment. 

 Here, assume that the settings shown below are set. 

 

Figure 5-4.  Device Setup Window – Standard Tab <After Setting> 
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<5> Switch to the Advance tab. 

 

Figure 5-5.  Device Setup Window – Advance Tab 

 

 
 

<Command options>  

Blank check before Erase: Checked  

Security flag after Program: Not checked 

Checksum after Program: Checked 
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<6> Click  OK .  The GUI software sets the parameters. 

 When the settings are completed, the following screen is displayed. 

 
Figure 5-6.  Completion of Parameter Setting 

 

 
 

(6) Selecting a user program 

 

<1> Select [File] → [Load]. 

<2> Select a program file to be written to the target device, then click  Open . 
 

Figure 5-7.  After Loading File 
 

 

“PRM File Read OK.” is displayed

Parameters are updated.

Parameters are updated.

"Success read HEX file." is displayed.



CHAPTER  5   USAGE  EXAMPLE 

User’s Manual  U17307EJ2V0UM 54

(7) [Autoprocedure (EPV)] command execution 

Select [Device] → [Autoprocedure (EPV)] from the menu bar. 
When the [Autoprocedure (EPV)] command is executed, [Erase] → [Program] are executed sequentially for the 

µPD78F9222.  In this example, “Blank check before Erase” and “Checksum after Program” are checked.  So, 

blank check is performed before the execution of the [Autoprocedure (EPV)] command, and checksum is 

performed after the execution of the [Autoprocedure (EPV)] command. 
 

Figure 5-8.  After EPV Execution 

 

 
 

(8) Terminating the system 

<1> If other devices need not be programmed, select [File] → [Quit] to terminate the GUI software.   
 All settings executed so far are saved in the FPL2.INI file, so that those settings can be reused when the 

GUI software is restarted. 

<2> Disconnect the target cable from the target system. 

<3> Disconnect the USB cable from the FPL2. 

 

 

(9) Restart 

When the system is restarted, the same screen as shown in Figure 5-6 appears. 

"...finish" is displayed.
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CHAPTER  6   CONNECTORS  AND  CABLES 
 

 

6.1 USB Connector (FPL2) 
 

Figure 6-1.  Pin Layout of Power Supply Connector 

 

1 5

 
 

Table 6-1.  Pin Assignment of USB Connector 

USB Connector FPL2 Signal Name 

1 5 V 

2 DM 

3 DP 

4 N.C. 

5 GND 

 
Connector part number:  UX60A-MB-5ST (made by Hirose Electric) 

 
 

Caution The recommended USB cable (Mini-B type) for connection with the host machine is the USB 

cable included with the QB-78K0SKX1MINI. 
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6.2 Target Cable Connector (FPL2) 
 

Figure 6-2.  Pin Layout of Target Connector 

 

 
 

Table 6-2.  Pin Assignment of Target Cable Connector 

Target Connector FPL2 Signal Name 

1 GND 

2 RESET 

3 VDD 

4 GND 

5 DGCLK 

6 GND 

7 DGDATA 

8 GND 

 
Connector part number:  DF3A-8P-2DSA (made by Hirose Electric) 

 
 

1 8 
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6.3 Target Cable Specifications 
 
 

Figure 6-3.  External View of Target Cable 
 

 
 

 

Table 6-3.  Pin Assignment of Target Cable  

 

 

 

 

 

 

 

 

Supported header pin specification:  0.635 × 0.635 mm (length:  6 mm) 
 

Remark The recommended header pin that can be used with the target cable is FFC-5AMEP1 

(made by Honda Tsushin Kogyo). 

 

6.4 Target Connector (FPL2-FA) 
 

Figure 6-4.  External View of Target Connector 

 

 
 

Table 6-4.  Pin Assignment of Target Connector 

Target Connector FPL2-FA Signal Name 

0 GND 

1 RESET 

2 VDD 

3 DGCLK 

4 DGDATA 

 
Connector part number:  FFC-5AMEP1 (made by Honda Tsushin Kogyo) 

 

 

Cable Specification Display 

Specification 

No. 1 Black GND 0. GND 

No. 2 Brown RESET 1. RESET 

No. 3 Red VDD 2. VDD 

No. 5 Yellow DGCLK 3. DGCLK 

No. 7 Blue DGDATA 4. DGDTA 

4 

 

 

0 
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6.5 FP4 Connector (FPL2-FA) 
 

Figure 6-5.  External View of FP4 Connector  

 

 
 

Table 6-5.  Pin Assignment of FP4 Connector 

FP4 Connector FPL2-FA Signal Name 

(Inside Parentheses: FP4 Signal Name)  

1 GND 

2 RESET 

3 DGDATA (RXD) 

4 VDD 

5 DGDATA (TXD) 

9 DGCLK (CLKOUT) 

14 DGCLK (FLMD0) 

6, 7, 8, 10, 11, 12, 13, 15, 16 N.C. 

 
Connector part number:  8516-4500SC (made by Sumitomo 3M) 

 

Remark The recommended receptacle connect that can be used with the FP4 connector is 

8516-4500SC (made by Sumitomo 3M). 

 

1 

2 

15 

16 
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6.6 List of Interface Connections 
 

Table 6-6.  List of Interface Connections 

Signal 

Name 

<1> Target Cable 

Connector 

<2> Tip of Target Cable <3> Target Connector <4> FP4 Connector 

GND 1, 4, 6, 8 0. GND 0 1 

RESET 2 1. RESET 1 2 

VDD 3 2. VDD 2 4 

DGCLK 5 3. DGCLK 3 9, 14 

DGDATA 7 4. DGDATA 4 3, 5 

 
Figure 6-6.  Target Interface 

 
 

 

  Target cable   FPL2-FA   PG-FPL2 

<1> 
<2> <3> <4> 
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CHAPTER  7   NOTES  ON  TARGET  SYSTEMS 
 

 

This chapter explains the basic notes on the target system for rewriting the flash memory in the microcontroller 

using the FPL2. 

 

CPU Pin Design Proposal 

Do not connect the RESET signal generator on the target system to the RESET signal of the FPL2.  Otherwise, 

a signal conflict will occur.  To avoid the conflict, isolate the RESET signal generator from the RESET signal of 

the FPL2.  

Do not generate RESET while the FPL2 is connected.  This must be especially noted in a system that uses an 

external watchdog timer. 

RESET 

Connect the RESET signal of the FPL2 at a point where the status of the programmer RESET signal and that of 

the CPU RESET pin are the same. 

 

Correct connection: 

 
CPU

FPL2 RESET 

RESET

 
 

Avoid the following RESET signal connection. 

• Connection to a point where the target CPU RESET rise time is slower than the FPL2 RESET rise time. 

 

Incorrect connection: 

 
CPU

OCFPL2 RESET 

RESET

 

It takes time for the CPU RESET pin to go high after the FPL2 RESET level goes from low to high. 
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CPU Pin Design Proposal 

RESET • Connection to a point where the target CPU RESET pin cannot be driven to low level by the FPL2 RESET 

signal. 

 

Incorrect connection: 

 

A 

CPU

FPL2 RESET 

RESET

 

When the FPL2 RESET is driven low, the level of the voltage at point A does not fall. 

Serial 

interface pin 

When the CPU port used by the FPL2 is also connected to the input of an external device, and if that device 

malfunctions, disconnect the external device or make it output high impedance. 

 

Example: 

 

Adverse effect

FP4
connector

Input

External device

CPU

RESET
X1 
X2 

 

While the CPU port used by the FPL2 is also connected to the output of an external device, and if a signal 

collision occurs, disconnect the external device. 

 

Example: 

 FP4
connector

Collision

Output

External device

CPU

RESET
X1 
X2 

 

 

Other For the unused pins, refer to the user’s manual of the device. 
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The following show examples of the interface circuits of UART (asynchronous communication port). 

Refer to the above design proposal for the pin processing of the device to be used. 

Figure 7-1.  UART Interface Circuit Example 

 

VCC

JUMPER
User reset circuit

VCC

VCCVCC

Connector

Microcontroller

IC

GND
RESET

DGDATA
VDD

DGDATA
N.C.
N.C.
N.C.

DGCLK
N.C.
N.C.
N.C.
N.C.

DGCLK
N.C.
N.C.

X1

X2

VDD

VSS

RESET

7616-5002SC

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16

R R

 
 

 

Cautions 1. The FPL2 generally performs normally without pin connection. 

 2. If the signals (X1, X2, RESET) used by the FPL2 are connected, pull up (or pull down), 

referring to CHAPTER 8 CIRCUIT DIAGRAMS. 

 3. Isolate the oscillator. 

 4. Pin 3 and pin 5 (DGDATA) are functionally equivalent.  Pin 9 and pin 14 (DGCLK) are 

functionally equivalent.  Connect the respective pins. 
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CHAPTER  8   CIRCUIT  DIAGRAMS 
 

 

Figure 8-1.  Circuit Diagram of FPL2-FA Main Unit 
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Figure 8-2.  Target Interface Block 
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CHAPTER  9   TROUBLESHOOTING 
 
 

9.1 Trouble During Setup 
 

(1)  When installing the driver, the driver is not recognized by Plug and Play. 

Cause: 

The USB connector may not be inserted normally into the USB port of the personal computer. 

Action: 

Check that the USB connector is inserted fully into the USB port of the personal computer. 

Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 
   
 

(2)  The driver file cannot be found at a specified location. 

Cause: 

The GUI software of the FPL2 may not be installed correctly. 

Action: 

Install the GUI software again by referring to 3.1 GUI Software Installation. 
 
 

(3)  "NEC Electronics IE-PC Interface [PG-FPL2]" is not displayed in the Device Manager.  Alternatively, the "!" or 

"×" is prefixed. 

Cause: 

The USB connector may not be inserted normally into the USB port of the personal computer. 

Action: 

Check that the USB connector is inserted fully into the USB port of the personal computer. 

Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 
 

Cause: 

The driver may not be installed correctly. 

Action: 

<1> Right-click the driver marked with "!" or "×" when the FPL2 is connected to the personal computer 

and select  Remove  in the right-click menu. 

<2> Execute [Hardware Modification Scan] in the Device Manager. 

<3> Install the driver again with Plug and Play. 
 

Cause: 

The device may not be recognized (in the case of connection with the USB hub). 

Action: 

Try the following: 

• Disconnect the USB connector, then insert the USB connector again. 

• Connect the USB connector to another port of the USB hub. 

 If the same symptom occurs, do not use the USB hub, but directly connect the connector to the USB 

port of the personal computer. 
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9.2 Trouble During Operation (Main Unit) 
 

(1) When the FPL2 is connected to the personal computer but the Power LED is not turned on. 

Cause: 

The FPL2 or the USB port of the personal computer may be damaged. 

Action: 

Try a connection to another personal computer. 

 

(2)  The "Add New Hardware Wizard" screen is displayed when the FPL2 is connected with a personal computer. 

Cause: 

If the USB connector of the FPL2 is not inserted into the USB port during installation but into another USB 

port, the FPL2 may be recognized as a new hardware item. 

Action: 

Install the driver by referring to 3.2 Driver Installation. 

 
 

9.3 Trouble During Operation (Communication) 
 

(1)  Communication with the target device is not possible. 

Cause: 

The driver may not be installed correctly. 

Action: 

Check if "NEC Electronics IE-PC Interface [PG-FPL2]" is installed correctly by referring to 3.2 Driver 

Installation. 

 

Cause: 

There may be an incorrect connection between the target cable and target system. 

Action: 

Check if the connection is correct. 

Pay special attention to the following connections because the connections are confusing: 

 Connect DGCLK of the target cable to X1 of target device 

 Connect DGDATA of the target cable to X2 of target device 
 

Cause: 

The power may not be supplied to the target device correctly. 

Action: 

<1> Check that the power is supplied in the target system. 

<2> If the power is supplied from the FPL2, check if the setting of the MODE switch is correct. 

 

Cause: 

The PRM file selected in the Device Setup window may be incorrect. 

Action: 

Use a PRM file that matches the target device. 

Refer to CHAPTER 4 OPERATION USING GUI SOFTWARE for information about PRM files. 

 

Remark  A parameter file (.prc) for FlashPro3 is unusable. 
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Cause: 

The power supply capacity of the USB port of the personal computer may be low (when the MODE switch 

is set to 3 V). 

Action: 

Try using another personal computer or supply power from the target system by setting the MODE switch 

to Target. 

 

Cause: 

Security may be set. 

Action: 

Check that security is not set. 

 

(2) The Status LED does not blink during erase operation. 

 

In accordance with the specifications of the FPL2, the Status LED may not blink during erase operation. 

To confirm the erasure status, check the following message in the action log window of the GUI software: 

 

 Message during erase operation: "Flash Erasing..." 

 Message for completion of erasure: "chip erase finish." or "all block erase finish." 

 

Cause: 

The power supply capacity of the USB port of the personal computer may be low (when the MODE switch 

is set to 3 V). 

Action: 

Try using another personal computer or supply power from the target system by setting the MODE switch 

to Target. 
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APPENDIX  A   PRODUCT  SPECIFICATIONS 
 
 

A.1 Hardware Specifications 
 

Table A-1.  Specifications of the Main Unit  

 MIN. TYP. MAX. 

Operating supply voltage (VDD_USB) 4.4 V 5.0 V 5.25 V 

Supply current (VDD_USB) − − 500 mA 

Current consumption of the main unit − 175 mA − 

3 V outputNote 2.9 V 3.1 V 3.4 V 

Target VDD voltage 2.7 V − 5.5 V 

VDD output current − − 200 mA 

 

Note The 3 V output of the FPL2 depends on the USB port of the host machine.  If the supply power of the USB 

port is unstable or does not satisfy the specifications of the target device, set the MODE switch to Target to 

use the power supplied from the target system. 
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A.2 Dimensions 
 

(1)  FPL2 

Figure A-1.  Dimensions of FPL2 Main Unit 
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 Unit: mm 
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(2)  FPL2-FA 

Figure A-2.  Dimensions of FPL2-FA Main Unit 
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(3)  Target cable 

Figure A-3.  Dimensions of Target Cable 

 

 

 
 

 

Figure A-4.  Dimensions of Tip of Target Cable 
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 Unit: mm 

Connector part number:  PS-SF-C2-1 (manufactured by JAE) 

120 30  

Tip Connector block 
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APPENDIX  B   WARRANTY AND SUPPORT 
 
 

B.1 Warranty 
 

This product (including hardware and software) is replaced free of charge in the case of an initial failure only. 

No warranty is provided for failures other than initial failures.  

 

B.2 Support 
 

No support is provided for this product. 

Visit the following site to obtain the latest information about this product: 

 

Site:  http://www.necel.com/micro/ods/eng 
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APPENDIX  C   REVISION  HISTORY 
 

 

The revision history is shown below.  Applicable Chapter refers to the chapter in each version. 

 

Version Revised Points Applicable Chapter 

Second Addition of APPENDIX B WARRANTY AND SUPPORT APPENDIX B WARRANTY 

AND SUPPORT 
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